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Goals

Customer Training Material

- The purpose of this tutorial is to introduce the user to good
techniques for accurately modelling flow in high speed external
aerodynamic applications.

* Transonic flow will be modelled over a NACA 0012 airfoil for which
experimental data has been published, so that a comparison can be
made.

* The flow to be considered is compressible and turbulent.

* The solver used is the density based implicit solver, which gives
good results for high speed compressible flows.

* The tutorial is carried out using ANSYS FLUENT and CFD Post from
within Workbench, but it could also be completed in standalone
mode.
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Sta rt a Wo rkbe n c h p rOj e Ct Customer Training Material

* Launch Workbench
— START > all programs > ANSYS 13.0 > Workbench

- Save the new project as ‘naca0012.wbpj’ in your chosen working
directory.
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Create folder structure and user files area

Customer Training Material

- Saving the project immediately creates a folder structure which
workbench will automatically manage.

* Included in the new folder structure is a ‘user _files’ area where
external files can be placed. This means that these files will be
archived with the project and not lost if the project is relocated.

- For this workshop, a mesh file has already been generated and
supplied. Experimental result files and case comparison files have
also been provided. Copy them all into the user_files folder:

working directory > naca0012_files > user_files >
NACA0012.msh
test-data-top.xy
test-data-bottom.xy
mach_0.5_comparison.cas.gz and mach_0.5_comparison.dat.gz
mach_0.7_converged.cas.gz and mach_0.7_converged.dat.gz

« Shortly we will be importing the mesh file into our Fluent simulation.
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View your file locations

Customer Training Material

* You can easily view the location of the files that are associated with
your project (View > Files).
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Pick a FLUENT system from the toolbox e

* Double-click or drag a Fluid Flow (FLUENT) analysis system from
your toolbox into your project workspace.

* If you wish, rename the FLUENT analysis, e.g. Mach_0.7
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Import the Supplied meSh file Customer Training Material

* Import the supplied FLUENT mesh file (naca0012.msh)
— Right click on Mesh (cell A3) and select ‘Import Mesh File’
— Browse to the mesh file which was placed into the user_files folder
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Import the Supplied meSh file Customer Training Material

* Note that because we have imported a mesh file the geometry tab is
automatically removed as it is not needed.

* Note also that the mesh cell now has a green tick to indicate that the
this part of the analysis system is completed and up-to-date.

* The next cell is the setup cell, used to open FLUENT and setup the
case so that it is ready to run.

* Right-click > edit (or just double-click the setup cell).
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Launch FLUENT to set up the case S E—————

* The FLUENT launcher will start.
— Note that ‘2D’ has automatically been selected based on the mesh file

— Keep the default options for everything else, click OK
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Dizplay Options Frocessing Dptians . .

v Dpisilaﬁhdesh After Feading = Serial o Double precision may yleld

W Embed Graphics Windows " Parallel more accurate drag prediction,
I ‘orkhench Color Scheme and is recommended in real
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[+ Show bMore Options
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Launch FLUENT to set up the case

* FLUENT will launch in a new window.
* The mesh will automatically read in and display (can be disabled).
* A settings file will automatically be written to the Workbench project.

[ A:Mach_0.7 FLUENT [2d, pbns, lam] [ANSYS CFD] NEE]
Fle Mesh Defnie Solve Adapt Surface Dsphy Report Paralel View Help

Customer Training Material

|G~ ~om@)S-aa 2@ im0
Problem Setup General
Wesh
Models
Materids scake.. | check | Report Quaity |
Phases Display.
Cell Zone Conditions
Boundary Conditions Solver
Mesh lqterfac:s Type Veloclty Formuiation 5 i
Dynamic Mes @ PressureBasec @ Absolute i
Reference Values  Density-Based (" Relative
Solution
Solution Methods Time 2D Space
Solution Controls @ Steady @ Planar
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Calculation Activities
Run Calculation I Graviy Units
Results S
Graphics and Animations | Help it
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Reports R
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Mesh Nov 17,2010
AMNSYS FLUENT 13.0 (2d, pbns, lam)

zones, el
default-interior
airfoil_lower
airfoil_upper
farfield
fluid
Done.

Preparing mesh for display...

Donhe.
Uriting Settings file...
writing rp variables ... Done.
writing domain variables ... Done.
writing fluid (type fluid) (mixture) ... Done.
writing farfield (type pressure-far-field) (mixture) ... Done
writing airfoil_upper (type wall) (mixture) ... Done.
writing airfeil_lower (type wall) (mixture) ... Done.
writing default-interior (type interior) (mixture) ... Done.
writing zones map name-id ... Done
< »
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Examine the mesh

Customer Training Material

« Zoom in and examine the mesh.

 The maximum aspect ratio in this mesh is quite high, as will be examined
shortly.

* This is a result of placing the first grid point in the viscous sublayer close
to the airfoil wall surface, for maximum accuracy in the turbulence model.

- However, very long thin (stretched) cells can lead to problems, so we
need to proceed with some checks.
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Scale the mesh

Customer Training Material

* First of all, it is always important to check the scaling of the mesh,
particularly when it has been imported from outside of workbench.

* Select General > Mesh > Scale and check the domain extents.
* In this case the domain extents are correct.
- If they are not, scale the mesh before proceeding any further!
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Check the mesh (general errors) ANSYS

Customer Training Material

 Check the mesh for errors: General > Mesh > Check

— Review the text window output and check there are no errors
— In particular make sure that the minimum cell volume is not negative

7 FLUENT [2d, pbns, lam] [ANSYS CFD]

— =] x|
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ANSYS FLUENT 13.0 (2d, pbns, lam)

N [
Domai tents:
- inate: min (m) = -1.999996e+01, max (m)

2.500000e+01
y-co inate: min (m) = -3.000000e+01, max (m)

3.000000e+01

minimum volume (m3 66491e-09

total volume (m3):

Face area statistics:

minimum face area (m2): 9.179116e-06

maximum face area (m2): 2.818221e+00
Checking mesh............ .
WARNING: The mesh contains high aspect ratio quadrilateral,
hexahedral, or polyhedral cells.|
The default algorithm used to compute the wall
distance required by the turbulence models might
produce wrong results in these cells. -
Please inspect the wall distance by displaying the
contours of the 'Cell Wall Distance’ at the

1.799309e+03
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Check the mesh (aspect ratio)

NANSYS

Customer Training Material

* In this case there are no errors reported with the mesh.

* Note, however, that we do have a warning which is a result of the
high aspect ratio cells within the boundary layer near the airfoil wall.

FLUENT [2d, pbns, lam] [ANSYS CFD] _[=]x]]
Fle Mesh Defne Sove Adapt Surface Display Report Paralel View Help

lvdrmoel|sl+aa 2@ Lmmg-0-
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Mesh Nov 17,2010
AMSYS FLUENT 13.0 (2d, pbns, lam)

Face area statistics: =
minimum face area (m2): 9.179116e-06
maximum face area (m2): 2.818221e+00

: The mesh contalns high aspect ratio quadrilateral,
hexahedral, or polyhedral c¢ells.
The default algorithm used to compute the wall
distance required by the turbulence models might
produce wrong results in these cells.
Please inspect the wall distance by displaying the
contours of the 'Cell Wall Distance' at the
boundaries. If you observe any irregularities we
recommend the use of an alternative algorithm to
correct the wall distance.
Please select /solve/initialize/repair-wall-distance
using the text user interface to switch to the
alternative algorithm.
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Check the mesh (aspect ratio)

Customer Training Material

* Report the mesh quality statistics:
— General > Mesh > Report Quality
— Note the maximum aspect ratio is high at 2655

lach_0.7 FLUENT [2d, pbns, lam] [ANSYS CFD] _l= x|
Fle Mesh Defne Solve Adapt Surface Dispay Report Paralel View Hep

|G~d~me|sEaas||@nm-0-

Problem Setup General
Mesh
Models

Phases Dispay...

Cel zone Conditions
Boundary Conditions | Solver
Mesh Interfaces

Type Velocity Formulation
Dynamic Mesh @ Pressure-Basec @ Absolute
Reference Values " Densty-Based (" Relative

Solution
Solution Methods Time 2D Space
Solution Controls (@ Steady @ Planar
Monitors (" Transent " Axisymmetric
Solution Initialization " Axisymmetric Swir
Calcuiation Activities P
Run Calculation Gravity Tz

Results

Graphics and Animations | Help

N
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Reports

77
=
i
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esh Nov 17,2010
ANSYS FLUENT 13.0 (2d, pons, lam)

hexahedral, or polyhedral cells. il
The default algorithm used to compute the wall

distance required by the turbulence models might
produce uwrong results in these cells.

Please inspect the wall distance by displaying the
contours of the 'Cell Wall Distance’ at the
boundaries. If you observe any irregularities we
recommend the use of an alternative algorithm to
correct the wall distance.

Please select /solue/initialize/repair-wall-distance
using the text user interface to switch to the
alternative algorithm.

Mesh Quality:

Orthogonal Quality ranges from @ to 1, where values close to @ correspond to low quality.
Minimum Orthogonal Quality = 3.96389¢-02

Maximum Aspect Ratio = 2.65535e+03

1] 3
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Check the mesh (aspect ratio)

Customer Training Material

- As a guide, the cell aspect ratio should be around 5 or less in the
main region of the mesh (away from the boundary layer).

- However, it is usual to have much higher aspect ratio cells than this
in the boundary layer, up to around 100.

* In this case, the maximum aspect ratio in the boundary layer is much
higher than this, but the mesh was designed in this way due to the
need for very low Y+ values. Away from the boundary layer the
maximum aspect ratio is around 5.

 For this special case the high maximum aspect ratio is justified.
* Not all cases require such a well resolved boundary layer mesh.

- Be aware that such high aspect ratio cells can give problems in the
solver calculations near to the wall, hence the warning when the
mesh quality metrics are reported.

* It is necessary to check that the solver is computing the wall distance
correctly, as this will be used in the turbulence model when we
switch it on.

ANSYS, Inc. Proprietary Release 13.0
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Check the mesh (wall distance check)

NANSYS

Customer Training Material

* FLUENT suggests a method to check the wall distances that are
calculated by the solver.

- The cells need some (any) data before we can post-process any
variables, including wall distances, so initialize the flow:

— default values are fine at this stage

<] A:Mach_0.7 FLUENT [2d, pbns, lam] [ANSYS CFD]
Fle Mesh Define Solve Adapt Surface Display Report Parallel View Help|

lGrd-mels/-aas||@ainEm-0-

Problem Setup

General
Models

« Solution Initialization > Initialize e

Cell Zone Conditions Compute from

Boundary Conditions I ﬂ

Mesh Interfaces

Dynamic Mesh

Reference Values
Solution

Solution Methods Initial Values

Solu_tm Controls . ) ;l
[y |
Run Calculation XU\Jeloctv (mfs)
Results
Graphics and Animations Y Velocity (m/s)
Plots | 0
Reports
=]
Tnitaize |Reset | Pichi |

SolRees | Rlesel Statistics |

Help
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Check the mesh (wall distance check)

NANSYS

Customer Training Material

 Now we can use the contour plot facility to report the wall distances.
* Graphics & Animations > Contours > Set Up

[@&] A:Mach_0.7 FLUENT [2d, pbns, lam] [ANSYS CFD]

File Mesh Define Solve Adapt Surface Display Report Paralel View Help

Problem Setup Graphics and Animations
General Graphics
Models
Materials
Phases
Cell Zone Conditions Pathiines
Boundary Conditions Particle Tracks

Mesh Interfaces

Dynamic Mesh

Reference Values Set Up...
Solution

Solution Methods
Solution Controls
Monitors

Solution Initialization
Calculation Activities
Run Calculation

Animations

Scene Animation
Solution Animation Playback

QOptions... Scene... Views...
Lights... | Colormap...| Annotate...

Help
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Check the mesh (wall distance check)

Customer Training Material

» Select Contours of Mesh > Cell Wall Distance
« Choose the airfoil wall surfaces (airfoil _lower and airfoil _upper)
- Deselect global range (report the local range of these surfaces only)

E
Options Contours of CIiCk ‘Compute,
[ Filed IMesh... j
v [Jode yaliles
ICeI Wall Distance v| . .
ﬁ:m@ ) Ve ) The minimum computed cell wall
[T Clipto B 8.199772e-07 7.113093e-06 H = -
Bicparas || distance is 8.2e-07 m
LR a?r‘r:cql_lcmrer
) arfol ypper The maximum computed cell wall
evels Setup

distance is 7.1e-06 m

| 20 j’ | 1
Surface Name Pattern New Surfacer |

[ eteh Sutace types =[] For the airfoil wall surfaces these
Sp-surt B are as expected from the mesh
Pt = design, so we can proceed with

our normal set up.

Display | Close Help |
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Check the mesh (some notes on Y+) S

* Y+ is the non-dimensional normal distance from the first grid point
(the wall-adjacent cell center) to the wall.

- If the first grid point is placed within the viscous sublayer (the near-
wall region where y+ <=5), the turbulence model's enhanced wall
treatment (EWT) option should be chosen. When using EWT, the
intention is to integrate governing equations directly to the wall
without using the Universal Law of The Wall for turbulence.

* The aspect ratio could be reduced, while keeping the same Y+ value:

— by keeping the same first cell distance
— and increasing the number of nodes along the wall surface
* reduces the length of cells for a given height so will reduce the aspect ratio

* this would significantly increase the overall cell count
« for this tutorial, the cell count has been kept low while maintaining low Y+

Release 13.0

ANSYS, Inc. Proprietary
December 2010
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Check the mesh (some notes on Y+) S

* The aspect ratio could also be reduced, while increasing Y+ value:

— by increasing the normal distance of the first grid point from the wall to give
Y+ values of between 30 and 300.

— This is the valid range of y+ for using the wall functions approach.

— Avoid placing the first grid so that 5 < y+ < 30, which is called the buffer layer.
(Due to the large variation of various turbulence source terms in the buffer
layer, no existing models can handle the wall treatment well if the first grids
lie in this region.)

ANSYS, Inc. Proprietary Release 13.0
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Check the mesh (orthogonal quality)

Customer Training Material

* In addition to maximum aspect ratio, the minimum orthogonal quality
is also reported:

— 1 is the best quality, 0 is the worst quality.

* For this mesh, the minimum value is reported as 3.96e-02 which is
again the result of highly stretched cells in the boundary layer.

* This can be examined further using the contour panel again:

— Contours of Mesh > Orthogonal Quality

Deselect all surfaces
Select global range
Select Filled

Display

ANSYS, Inc. Proprietary Release 13.0
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Check the mesh (orthogonal quality)

Customer Training Material

* Most cells are good quality, many are around 1 (shown in red)

T

Cpftions
¥ Filed Mesh... ~|
[+ Node Values
[ Giobal Range [orthogonal Qualty ] ———— mrE
[v Auto Range i 12y —
CIp o range [ 0.03995419 [0.9994572 B
| Draw Profies —
[~ Draw Mesh SLIEEES IS
irfoil_lower
irfoil_upper Tove
Levels Setup efault-interior e
I 20 il I 1 il arfield | o
szt

3.76e-01
Surface Name Pattern New Surfacer | 226001

2.80e-01

I Match | rface pes =| = I 232601

Su T‘-" = 1.84e-01

i 1.36e-01

F e
axis 8.79e-02
clip-surf 400802
exhaust-fan
f; - Contours of Orthogonal Quality Nov 17,2010
dn ANSYS FLUENT 13.0 (2d, pbns, lam)
hexahedral. or polyhedral cells. =]

The default algorithm used to compute the wall

distance required by the turbulence models might
i produce urong results in these cells.
‘ ComDUte Ckm I-Hp | Please inspect the wall distance by displaying the
contours of the 'Cell Wall Distance’ at the
boundaries. If you observe any irregularities we

recommend the use of an alternative algorithm to
correct the wall distance.

Please select /solue/initialize/repair-wall-distance
using the text user interface to switch to the
alternative algorithm.

Mesh Quality:

Orthogonal Quality ranges from @ to 1, where values c¢lose to 0 correspond to low quality.
Minimum Orthogonal Quality = 3.96389e-02

Maximum Aspect Ratio = 2.65535e+03

< »
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Check the mesh (orthogonal quality)

Customer Training Material

- Zoom in to the boundary layer cells near the airfoil wall, these cells
are blue (low orthogonal quality) due to the stretched cells.

* In particular this can be seen where they meet at the trailing edge.

FLUENT [1] ANSYS Inc — (O] x|

8 04e-01
8.56e-01
8.08e-01
7.B0e-01
7.12e-01
B Bde-
B 16e-01
5 68e-01
5.20e-01
4.72e-01

24e-01
3.76e-01
3.28e-01
2 80e-01
2.32e-01

Contours of Orthogonal Quality Mow 17, 2010
ANSYS FLUENMT 13.0 (2d, pbns, 1am)
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Check the mesh (proceed)

Customer Training Material

* High aspect ratio cells and low orthogonal quality cells have been
identified in the mesh.

— Both are located in the stretched boundary layer cells.

 This is acceptable in this airfoil drag-prediction case, where low Y+
values can lead to high aspect ratio cells.

— More grid points along the airfoil wall surfaces would reduce the aspect
ratio, but increase the overall mesh size.

* The cell wall distance computed by the solver, and needed for the
turbulence model, has been checked.

* Proceed with this mesh and set up the case.

ANSYS, Inc. Proprietary Release 13.0
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NANSYS

Case Setup: Choose the solver and models

- Select the steady-state density-based solver:
— General > Solver > Type > select ‘Density-Based’
— General > Solver > Time > steady (default)

ANSYS, Inc. Proprietary

@] A:Mach_0.7 FLUENT [2d, dbns imp, lam] [ANSYS CFD]
File Mesh Define Solve Adapt Surface Display Report Paralel View Help

|Grd~m@|s+aasz]|@inEm-0r-

Problem Setup
Models
Materials
Phases
Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values
Solution

Solution Methods

Solution Controls

Monitors

Solution Initialization

Calculation Activities

Run Calculation
Results

Graphics and Animations

Plots

General
Mesh

Scale.. |  Check | Report Quaity |
oluer
Type Velocity Formulation
" Pressure-Basec [| (% Absolute
® Density-Based [ Relative
Time 2D Space
® Steady ® Planar
" Transient " Axisymmetric

" Axisymmetric Swir

[ Gravity Units...
Help

Customer Training Material

Release 13.0
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Case Setup: Choose the solver and models

Customer Training Material

* Turn on the energy equation.
— Models > Energy > Edit > Toggle ‘On’

— This is needed because the flow is compressible and temperature will be
variable.

7 A:Mach_0.7 FLUENT [2d, dbns imp, lam] [ANSYS CFD]
File  Meshy Define Sokve Adapt Surface Display Report  Paralel  Wiew  Help

General Models = EncTig

Dhoce Energy
terss W
Phases ECOUS - Laminar I I7 Energy Equation

Cell Zone Conditions Radiation - Off
Boundary Conditions Heat Exchanger - Off
Mesh Interfaces Species - Off OK | Cancel | Help |
Dynamic Mesh Discrete Phase - Off
Reference Values Acoustics - Off
Solution
Solution Methods
Solution Controls
Manitors
Solution Initialization
Calculation Activities
Run Calculation
Results

Graphics and Animations ||
Plots
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Case Setup: Choose the solver and models

Customer Training Material

* Select the turbulence model to be used:

* Models > Viscous > Edit
- Choose k-omega (2-eqn)
* Select SST, then OK

@] A:Mach_0.7 FLUENT [2d, dbns imp, lam] [ANSYS CFD] S Viscous Model x|
Fle Mesh Define Solve Adapt Surface Display Report Paralel View Help Model _—
: - " Inviscid Alpha*_inf =
|Ervd-me|seaazearnEmyoO- F o
" Spalart-Almaras (1 eqn)
Problem Setup Models (" k-epsilon (2 egn Alpha_inf
* k-omega (2 eqn) | 0.52
General Models ransiion k-k-omega (3 egn)
Model Multiphase - Off " Transition SST (4 eqn) Beta*_inf
Materials “on ” Reynolds Stress (5 eqn) I 0.09
s [ e — C sclesdape bk 55, ||
Cel Zone Conditions iaton - Off k-omega Model 15
Boundary Conditions Heat Exchanger - Off arc I : =~
Mesh Interfaces Species - Off ® ssT User-Defined Functions
Dynamic Mesh Discrete Phase - Off - )
Acoustics - Off k-omega Options Turbulent Viscosity
Reference Values 7 .
Ut ‘ [~ Low-Re Corrections ‘ Inone ﬂ
Solution
e et Options Prandtl Numbers .
U ! n Me s Energy Prandtl Number =
Solution Controls = Inone ﬂ
Monitors
. - . Wall Prandt! Number
Solution Initialization |none J
Calculation Activities
Run Calculation | |
Results ‘ =]
Graphics and Animations | § EdIL... g [l o
Plots [ESy
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Case Setup: Define Materials

Customer Training Material

» Constant density air is the default fluid.
— This must be modified for compressible flow.

- Materials > Fluid > Air > ‘Create/Edit’
— For Density, select ‘Ideal Gas’

— For Viscosity, select ‘Sutherland’
* Accept the default settings for the Three Coefficient Method

* The Sutherland law for viscosity is well suited for high-speed compressible
flow.

— For simplicity, we will leave Cp and Thermal Conductivity as constant.

— ldeally, in high speed compressible flow modeling, these should be temperature
dependent as well.

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Define Materials ANSYS

Customer Training Material

F
Name Material Type Order Materials by
I air Iﬂuid ﬂ ® Name
) " Chemical Formule
Chemical Formula FLUENT Fluid Materils
| far | T
Mixhre User-Defined Database...
|none =l
Properties
IDensity (kg/m3) Iided-ga's Ij Edit.., =
Cp (Spedific Heat) (i/kg-k) |oonstant =] CElE
| 1006.43
Thermal Conductivity (w/m-k) I rEETh j Edt.,,
| 0.0242
viscosty (ka/m-S) [ayeheriand = = @
=i
| Changefcrﬂatell_ pekte: | __oose | wp | @ sutherland Law x|

Methods
#t"‘ Two Coefficient Method (SI Units Only’

® Three Coefficient Method

Click ‘Change/Create’

[Reference Viscosity, mu0 (ka/m-s) [ { 716e-05 :I

Close the materials panel. Reference Temperature, TO (k) { 273.11

me@rﬂturﬂr 5| 11056

| oK I Cancel|  Help |

ANSYS, Inc. Proprietary

Release 13.0
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Case Setup: Assign Materials

Customer Training Material

* Check that ‘air’ is assigned to the cell zone ‘fluid’

* Cell Zone Conditions > Zone > ‘fluid’ > edit
— In this case there is only one cell zone (with the default name of fluid)
— In this case there is also only one material (air, which has been modified)

— There can be multiple zones with user-specified names and multiple
materials if required

* There is nothing else to assign to the fluid cell zone for this case

— Other tabs are enabled when the corresponding options are selected
x|

-
Zone Name

| fluid

Material Namela-‘r - I Edit... |

[~ Frame Motior [ Laminar Zone | Source Terms
[ Mesh Motior [ Fixed Values
" Porous Zone

Reference Frame | Mesh Motbn' Porous Zone' Embedded LES| Readjon' Source Terms| Fixed Values| Multiphase

Rotation-Axis Origin ﬂ
X (m) I 0 Iconstant j

Y (m) I 0 Iconstant j

[
Cancel Help |

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Operating Conditions

Customer Training Material

« Cell Zone Conditions > Operating Conditions
— Note: can also be accessed from the boundary conditions panel

* Absolute pressure = operating pressure + gauge pressure

— For incompressible flows (where pressure changes are relatively small)
it is normal to specify a large operating pressure and let the solver work
with smaller ‘gauge’ pressures (FLUENT input/output values), to reduce
round-off errors.

— For compressible flows, the solver needs to use the absolute values in
the calculation anyway, so numerically this makes no difference.

Therefore, with compressible flows, it is sometimes X
convenient to set to operating pressure to zero, and Pressure Gravity
input/output ‘absolute’ pressures. ‘I:)peraﬁng Pressure (pascal) | [~ Gravity
0

]
This is simply a user preference. Other times it may be Reference Pressure Location
convenient to set a bulk flow operating pressure. X (m)| 0 o

Y (m)
The main thing to remember is that whatever operating ID El
pressure is set, this will be added to any gauge input £(m]o 4
pressures.
Set Operating Pressure to 0 Pa Cancel| _Hep |

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Boundary Conditions

NANSYS

- Boundary Conditions > Zone > select ‘airfoil _lower’
* Check that the boundary zone type is set to ‘wall’

— If not, use the drop down list to change!
« Edit > Momentum Tab

Customer Training Material

— leave the default settings which correspond to a stationary wall (relative

to the fluid zone) with a no-slip condition.

@ A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD] A wall x|
Fle Mesh Define Solve Adapt Surface Display Report Paralel View Adjof Zone Name
lE~d~me|s[+aa #||a g0~ Iairfoil_bwer

Problem Setup
General
Models
Materials
Phases

Boundary Conditions

w

default-nterior
farfield

Adjacent Cel Zone

| fluid

Thermal| Radiation | Species| DPM | Multiphase| UDS |

Wall Motion

Motion

Dynamic Mesh
Reference Values
Solution
Solution Methods
Solution Controls
Monitors
Solution Initialization
Calculation Activities

Run Calculation
Results

Graphics and Animations | 1252 S — i8]
Reports

Ed... |E|“_"'|_9

Parameters...

Operating Conditions... |

Display Mesh...

Periodic Conditions. . |

I¥ | Relative to Adjacent Cell Zome ‘

® Stationary Wal
" Moving Wal
Sheac Condii
* No slp
" Speciied Shear

€ Specularity Cosfficient
(" Marangoni Stress

Wal Rouanesm ‘

Roughness Height (m)l 0

| constant |

|constant ~|

Roughness Constant I 0.5

ANSYS, Inc. Proprietary

aK | Cancell Help |
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Case Setup: Boundary Conditions ANSYS

Customer Training Material

* Thermal Tab

— Remember that the energy equation is switched on so thermal boundary
conditions must be applied.

— Leave the default setting (zero heat flux) which corresponds to an
adiabatic wall

= wall
Zone Name
I airfoil_lower

x|

Adjacent Cell Zone
| fluid

MomentumRadiaﬁon' Species| DPM | Muttiphase| UDS |

& Heat Flux
(" Temperature
(" Convection
(" Radiation
" Mixed

1
I Heat Flux (wfmz)l 0 |constant j

Wall Thickness (m) I 0

Heat Generation Rate (wfm3)| 0 |c0nstant j

Material Name

aluminum j Edit... |

OK ' Cancell Help |

ANSYS, Inc. Proprietary
© 2010 ANSYS, Inc. All rights reserved.
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Case Setup: Boundary Conditions

Customer Training Material

- Boundary Conditions > Zone > ‘airfoil_upper’

— Check that the boundary zone type is set to ‘wall’
* If not, use the drop down list to change!

— Edit > Momentum Tab and Thermal Tab
* Repeat as for airfoil_lower (no-slip, adiabatic)

- Boundary Conditions > Zone > ‘farfield’

— Check that the boundary zone type is set to ‘pressure-far-field’
* If not, use the drop down list to change!

— Edit > Momentum Tab and Thermal Tab
* See next slides

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Boundary Conditions

- Set the far field boundary conditions:
— The pressure-far-field boundary is applicable only when using the ideal-gas law.

— It is important to place the far-field boundary far enough from the object of
interest.

* For example, in lifting airfoil calculations, it is not uncommon for the far-field boundary to
be a circle with a radius of 20 chord lengths.

Customer Training Material

— This workshop will compare CFD with wind-tunnel test data.

— We need to input the static pressure at a far-field boundary.

— We can calculate this from the total pressure, which .
was atmospheric at 101325 Pa in the test. Po _ {1 + EEJMZ}M

— We have already set the operating pressure to zero,
so we are now working in absolute pressure values.
Hence the ‘gauge’ static pressure input will be equal
to the ‘absolute’ static pressure value, which we will

where
p, = totalpressure =101325 Pa

calculate to be 73048 Pa, for a Mach number of 0.7 p = static pressure
vy =1.4 for air
— On the ‘Momentum’ tab M =Mach No.=0.7
+ set the gauge static pressure to 73048 Pa & —1.3871
* set the Mach Number to 0.7 p
p =73048 Pa

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Boundary Conditions e

* The angle of attack (a) in this case is 1.55 deg. The x-component of the flow
is cos a and the y-component is sin a.

— Set the flow direction components as shown

— It is common practice to adjust the numerical a from the experimental a in order to match the lift obtained in
the wind tunnel, and then to determine the drag associated with this lift. This adjustment of a is carried out to
counter the effects of the wind tunnel enclosure.

x|
.. Zone Name
+ Set reasonable boundary conditions ||frfe
for the far field turbulence: Momentum | Therma| Radiation| Speces| Ups | ppM |
Gauge Pressure (pascal) § 73043 Iconstant j
« Select ‘Intensity and Viscosity Ratio’ Mach Numberf o.7 [constant =
- Set the intensity to 1% X-Component of Flow Directon f 0.99963 [constant =
- Set the viscosity ratio to 1 Y-Component of fiow brecton {0 02705 fconstant [
Turbulence
Specification Methodfintensity and Viscosity Ratio ~|
Turbulent Intensity (%) 1
Turbulent Viscosity Ratiof

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Boundary Conditions e

» Select the thermal tab.

— The wind tunnel operating conditions for validation test data give the
total temperature as T, =311 K

— We can therefore calculate the static temperature to be 283.24 K

x| % 1. ( y-1 j I
Momentum| Thermal | Radiation| species| ups | DPM |

Temperature (K) [B8520 ] |constant ~] where
T, = total temperature =311K
T = static temperature
v =1.4 for air
M =Mach number =0.7

To =1.098 andso| T =283.24K

ANSYS, Inc. Proprietary Release 13.0
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Case Setup: Reference Values —————————

» Set the reference values

— These are not used to compute the flow solution, but they are used to
report coefficients, such as Cp.

* Use the free-stream as a reference condition.

Select ‘compute from farfield’ in the drop down list. (3 A:Mach_0.7 FLUENT [2d, dbns imp, sstiow] [ANSYS CFD
Fle Mesh Define Solve Adapt Surface Display Report Paralel View Help
[ d-me|sl+aa e imyo-|
Reference values for velocity, density, temperature, etc. | robenseup Reference Values
will update from the free-stream values. o Senbuion 2
Materials
Reference Values

Phases
Cel Zone Conditions

Boundary Conditions
Mesh Interfaces

Area (mZ)I 1

Density (kgfm3)| 0.898489

Set the following to represent a chord length of 1m

ference Value Depth(m)|1
with unit depth: oo Hethods Enthalpy (0)| 512626 4
sotin orrs angtn o
reference length =1m oon Incaizaron Pressure (pasca) [ 73047.58
reference depth =1m i caaton Temperature (9 253.239
reference area = 1m?2 Graphics and Animatons Veocty (m/s)| 2360762
Reports Viscosity (kg/m-s)l 1.7894e-05

Ratio of Specific Heatsl 1.4

These are not updated from the farfield conditions, but
the defaults happen to be 1 already. porce one 5

ep|
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Case Setup: Solution Methods

Customer Training Material

- The CFD model itself is now defined, but the solver settings need to be
modified. These dictate how fast, stable and accurate (for the given mesh
and model choices) the solution will be.

¢ Solution Methods >

— Keep the default settings for implicit formulation and Roe-FDS flux type.

* The explicit formulation is only normally used for cases where the characteristic time scale
is of the same order as the acoustic time scale, for example the propagation of high Mach
number shock waves.

* The implicit formulation is more stable and can be driven much harder to reach a
converged solution in less time.

— Change the gradient method to Green-Gauss Node Based.

* This is slightly more computationally expensive than the other methods but is
more accurate.

— Select Second Order Upwind for flow and turbulence discretization.
* To accurately predict drag, the default 15t order schemes are not sufficient.

ANSYS, Inc. Proprietary Release 13.0

© 2010 ANSYS, Inc. All rights reserved. December 2010




WS2: Transonic flow over NACA0012 Airfoil AN SYS

Case Setup: Solution Methods

@& A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD]
Fie Mesh Define Solve Adapt Surface Display Report Paralel View Help

Customer Training Material

Problem Setup Solution Methods
General Formulation
Models -
Im -
Materials I [ J
Phases Flux Type
Cel Zone Conditions |Roe-FDS -|
Boundary Conditions Spatial Discretization
r[-:esh In_tehr:atss T [
ynamic Mes
G -Gal Node Based
Reference Values I reen-tatiss < ll
Solution
: ISecond Order Upwind ﬂ
|Solution Methods Turbulent Kinetic Energy
Solution Controls
Monitors |Sec0nd Order Upwind ﬂ
Solution Inftialization Specific Dissipation Rate
Calculation Activities |second Order Upwind |
Run Calculation
Results 3
Graphics and AnIMations | - cic - o Ao
i | =
Reports

|_ MNem Iteratve Time Advancermemat
™| Frozen Al Formulatior
[ Pseudo Transient

Default |

Help
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Case Setup: Solution Controls

Customer Training Material

* The Courant number (CFL) determines the internal time step and

affects the solution speed and stability.
— The default CFL for the density-based implicit formulation is 5.0.

— It is often possible to increase the CFL to 10, 20, 100, or even higher, depending on the stability
of the solution. It may be that a lower CFL is required during startup (when changes in the
solution are highly nonlinear), but it can be increased as the solution progresses.

@] A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD]
Fie Mesh Define Solve Adapt Surface Display Report Paralel View Hel

Erd-me|slraa ]|jenn-0-|

Problen sctup SOLTOREOREE As we will be using automatic
otars 5 ‘solution steering’, the choice of CFL
Phases Under-Relaxation Factors . . . .

ceonecontns [ oy N at this stage is not important for this

Mesh Interfaces I 0.8 Case .

Dynamic Mesh e
Reference Values nge;:lﬁc EEspatoniRats

Solution

IT:rbuwmv Keep the default under-relaxation
Souton nteizaton || 0K factors (URFs) for the uncoupled
Calculation Activities 1
Rur'wtCalculation | pa ramete rS .

Results
Graphics and Animations LI
Repors octaut]

Equaljons...l Um'lts...l Advanced...
hep|
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Case Setup: Solution Monitors

NANSYS

Customer Training Material

» Set up residual monitors so that convergence can be monitored
— Monitors > Residuals > Edit
— Make sure ‘Plot’ is on

— Turn off convergence targets by setting the criterion to ‘none’.

« This means that the calculation will not stop at pre-defined convergence
criteria, but residual convergence can still be plotted.

@ Residual Monitors x|
Options Equations
¥_Print to Console Residual Monitor &
¥ Plot Iconljnu'rty 2
s = Ix—vebc‘rty [
1 I’ Curves...| Axes... |
|v-vebcitv v
Iterations to Plot
I 1000 il Ienergy v _I
&7 -
Residual Values Convergence Criterion
Tterations to Store [~ Normalize Itenations Inone ﬂ
I 1000 - E =
[ Scale
[ Compute Local Scalk
Plot | Renormaizel Cancel | Help |
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Case Setup: Solution Monitors

- Set up a monitor for the drag coefficient on the airfoil.

Customer Training Material

» Select both wall zones and toggle on ‘Print’, ‘Plot’ and ‘Write’.

— Remember that a is 1.55° so we need to use the force vector as shown.

- Lift and drag are defined (perpendicular and parallel respectively) relative to the free-
stream flow direction, not the airfoil.

@] A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD] . x|
Fle Mesh Define Solve Ada i You can SpeCIfy .
pt Surface Display Report Parallel View Help i : ptions wall Zones =|=
B R T FECCE Rk which window - airol_lower
, FLUENT uses to % Plot airfoil_upper
Problem Setup Monitors ) \
Gzr&er;l Residuals, Statistic and Force Monitors d |3p|ay pIOts- For \""";ndow _
M . -
Materais Residuals - Print, Plot now, accept the | EI Curves...| Axes... |
s [ defaults. ¥ write
Cell Zone Conditions File Name
Boundary Conditions Moment - Off

[

Dynamic Mesh E ) BT
Reference Values ! i

Surface Monitors

Mesh Interfaces I cd-history

Solution

Force Vector

X Y Z
0.99963 0.02705 0

Calculation Activities

Run Calculation Create... | Edit., | Dielete |
Results Volume Monitors

Graphics and Animations |

Plots

Plot | Clearl Cancell Helpl
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Customer Training Material

WS2: Transonic flow over NACA0012 Airfoil

Case Setup: Solution Monitors
« Set up a monitor for the lift coefficient on the airfoil in the same way.

— Note the force vector is different to the drag monitor

]
Wall Zones £ j

Options

[¥ Print to Console airfoil_lower
[+ Piot airfoll_upper
Window

|3 il Curves... | Axes... |

[ Write
File Name
I cl history

|_ Per Zone

Force Vector

X Y z
|-0.02?05 0.99963 IIu:u

oK | ot | cear | cancel|l Hep |

Release 13.0
December 2010
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Case Setup: Solution Initialization

Customer Training Material

- Initialize the flow field based on the farfield boundary:
— Solution Initialization > Compute from > farfield

@] A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD]

Fie Mesh Define Solve Adapt Surface Display Report Paralel View Helg
|Erd-me|sltaa 2||e -0
Problem Setup Solution Initialization
G?)ZEE Initialization Methods
Model  Hybrid Initalzation . L.
i @ standard Intaizator There will be existing data
ooy contons | oputefrom ﬂl from the earlier initialization
Mesh Interfaces .
Dynamic Mesh used for checking the cell
Reference Values ® Relative to Cell Zone .
Solution C Absolute wall distances, etc.
Solution Methods Initial Values
MS.;IﬁEg:gControb Gauge Pressure (pascal) = .
Solution Initialzationf | 73047.88 Click OK when prompted to
Run Calcuation rz‘;:;;; = discard the old data and
Results ’ = =
araphics and aoracors. [T overwrite with the new flow
Jmitiall ’ Plot .
— ‘Initialize roorts | 6385867 - data.
Temperature
|283.239
Turbulent Kinetic Energy (m2/s2)
|8.359831
Specific Dissipation Rate (1/s)
|41?291.8 L
| Initiaicze | IReset | Patch... | -
Reset DRI SoLirces | | Reset Statistics |
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Case Setup: Case Check

Customer Training Material

 Run Calculation > Check Case

— Check the case file and make sure there are no reported issues.

Fle Mesh Define Solve Adapt Surface Display Report Paralel View Help
|E-d-me|s+aa2||aim-0- —
@] case Check x|
Problem Setup Run Calculation
sz':jiﬁ' Preview Mest Motion. | Mesh | Models' Boundaries and Cell Zones' Materials SONEI'l
Materials " i )
e Number of Tterations . Reporting Interval . Manual IIT'IDEI'I"IEDIZ&DOH
Cel Zone Conditions I 0 z’ | !
Boundary Conditions Profile Update Interval Remmmendamn ﬂ
Mesh Interfaces 1 -
Dynamic Mesh . : Review reference values for non-dimensionalized force coefficients computed with force monitors. j
Reference Values ™ Solution Steering (Solution Controls)
Solution Data File Quantities... | AcOUStc Sigrals..,
Solution Methods
Solution Controls j
Monitors Calculate
Solution Initialization
w“ﬁ Help Apply | Close | Help |
esults
Graphics and Animations
Plots

— Any potential problems or reminders associated with the case setup will
be raised in the case check panel.

— In this case, in the solver tab, there is a recommendation to check the
reference values for the force monitors.

« Since we have already set these we can ignore this reminder.
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Case Setup: Solution Steering e

« Solution Steering

— uses ‘Full-Multi-Grid (FMG) Initialization’ which will compute a quick,
simplified solution based on a number of coarse sub-grids. This quick
solution can help to get a stable starting point and is a better ‘initial
guess’ for the main calculation

— employs robust first order discretization in the early-stages of the main
computation, then blends to the more accurate second order schemes as
the solution stabilizes

— gradually ramps up the CFL in line with stability

* Run Calculation >
—Toggle on Solution Steering
— Change the flow type to ‘transonic’

— More settings > reduce the Explicit Under-Relaxation Factor to 0.5

* this is recommended for second order discretization and should make the solution more
stable

Release 13.0
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NANSYS

[@& A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD]
Fle Mesh Define Solve Adapt Surface Display Report Paralel

View Help

Customer Training Material

|Erd-me|sitaa2||einmyor|

Problem Setup
General
Models
Materials
Phases
Cell Zone Conditions
Boundary Conditions
Mesh Interfaces
Dynamic Mesh
Reference Values
Solution

Solution Methods
Solution Controls
Monitors

Solution Initialization

Results

Graphics and Animations
Plots

Reports

Run Calculation

Check Case...

| Presyiew Mesh Motiorm, ., |

Number of Iterations Reporting Interval

Imou i“l i’

Profile Update Interval
E :

[+ Solution Steering

Flow Type
fl transonic

| ~| * use FMG Initiizatior

First to Higher Order Blending

R

First Order

vl

Second Orde

Courant Numberl c

Data File Quantities... | Leoustc Signals..,

Calculate |

Bl

| Steering Settings | FMG Settings |

Stage 1 Courant Number
Duration Initial Maximum
I 100 illteraﬁons I 5 I 200

Stage 2 Explicit Under-Relaxation Factor
Update the Courant Number 0.5
® Immediately
(" After

0 il [terations

Courant Number Update Interval

20 il Tterations
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R u n C a I c u I ati o n Customer Training Material

. Set th ree graphics Windows (@] A:Mach_0.7 FLUENT [2d, dbns imp, sstkw] [ANSYS CFD]
Fle Mesh Define Solve Adapt Surface Display Report Paralel View Help
— For the residual, lift and drag monitors EEFEFTE s
Problem Setup Run Calculation
fqiréer;l Check Case...
(=
H H Materials ST ;
* File > Save Project! phaces T
Cell Zone Conditions :l
Boundary Conditions Profie Update Interval
Mesh Interfaces 1 -
Dynamic Mesh <
= Reference Values [+ Solution Steering
* Run Calculation > scuteon —
N . Solution Methods Itransc::?s j - . )
— Set the number of iterations to 1000 Solton Contros e G aater
‘ ’ Solution Initilization First to Higher Order Blending
— Press ‘Calculate’. Coubton actvees ||| —
| % 4] _I»
Results First Order  Second Order
— Note: It is good practice to run and then check the FMG Sraphics and Animatons .
. . . . . i G TN
first (by setting the main iteration number to zero and Reports _More settngs.. ourant Number 5
then pressing calculate) before starting the main Data Fie Quantties... | Acoue S|
calculation iterations. The FMG calculation can diverge
just as the main calculation can do. Check for non- I Calculate

physical velocities, temperatures, etc. For this workshop,
the FMG has already been checked.

— The calculation should take about 15 minutes. Time for a
coffee? If you can’t wait, the converged case and data
files can be read from your user_files folder.
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R U n C a I C u I ati o n Customer Training Material

- After 1000 iterations the calculation has converged.

* Note that the CFL has been steadily ramped up during the calculation by the
solution steering algorithm. This can be seen in the CFL value displayed and
the effect on the residuals is also evident.

— The residuals have converged to low values and the drag and lift
monitors are no longer changing.

@] mach_0.7 FLUENT [2d, dbns imp, sstkw] — = x|
Fle Mesh Define Solve Adapt Surface Display Report Paralel View Help

|Grdrme|s+-aa s imyo-|

robiem etup Run Calculation 1: Scaled Residuals 2: Drag Convergence Hitor |
General CheckGase.. | | Preview eshotior. |
Models
Materals Number of Fterations Reporting Interval
Phases - [0 =[x -
el Zone Conditions = =
Boundary Conditions Profie Update Interval
Mesh Interfaces 1 -
Dynamic Mesh -
Reference Values [¥ Solution Steering
solution 3
Flow Type P o om w o@ m m @ om

Solution Methods E= Flm :
Solution Controls Use FMG Initializatior
Monitors

Solution Intiaization

Dragy Convergence History Dec 07, 2010

First to Higher Order Bending ANSYS FLUENT 12.0 (24, dons imp, Ssikw)

Calculation Activities
ey 100 gp 4 5 3: Lt Convergence History v
Results First Order  Second Order
Graphics and Animations
Plots More Settings... Courant Number
Reports oam
v2m
Data Fle Quanttes... | Acousic Sigids.. | 1e-07 o w2
0 100 200 800 400 500 600 VOO BO0 900 1000 P

Calculate lterations v
@
= (s

Scaled Residuals Dec 07, 2010 || g copyargence History Dec 07, 2010
ANSYS FLUENT 13.0 (2d, cons Imp, sstkw) ANSYS FLUENT 13.0 (20, dbns imp, ssthw)
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Post Processing [FLUENT]

NANSYS

Customer Training Material

Good agreement can be seen.

From Reference 1, Cl = 0.241 and Cd = 0.0079

The CFD solution predicts Cl = 0.241 and Cd = 0.0081

Compare the predicted Cl and Cd against the experimental values.
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Post Processing [FLUENT]

 Examine the contours of static pressure
— Graphics and Animations > Contours rmmrs

— Turn off ‘Filled’ to just display the
contour lines.

— Turn on ‘Filled’, display again.

Customer Training Material

* Note the high static pressure at the
nose, and low pressure on the upper
(suction) surface

x

B.86e+14
B.69e+04

%
&
£.33e404
6.06e+04 \/
5.79e404
5520404
5250404
( ]

4.98e+04

4.71e+04

7
Options Contours of Gontours of Static Pressure (pascal Nov 18, 2010
|7 Filed IPF&SUFE... j ANSYS FLUENT 13.0{2d, dbns imp, s5tkw)
[+ Node Values
Static Pressure -
F Global Range I = J B FLUENT [1] ANSYS Inc ol
[ Auto Range ir (pascal) e (pascal)
I™ cip fo Range I 47062.47 101029.1
[ Draw Profies
™ Draw Mesh e =
airfoil_lower
airfoil_upper
Levels default-interior

Setup
ITj”l—jl farfield

Surface Name Pattern ~ New Surfacer |
I Match | Surface Types g| =|

axis -
clip-surf
exhaust-fan
fan Ll
Contours of Static Pressure (pascal) Nov 18, 2010
ANSYS FLUENT 130 (2d, dbns imp, sstk)
Display | Compute | Close Help |
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Post Processing [FLUENT]

- Examine the contours of Mach Number
— notice that the flow is now locally supersonic (Mach Number > 1)

Customer Training Material

EIFLUENT [1] ANSYS Inc o]

x| 1.106+00 ANSNS

Options Contours of 1.05e+10 13°0
[ Filed [veocty... ~| 22;:31
E g(k))db;vl:zl;?e |Mach Number j 8.53e-01
[+ Auto Range I Il 8.28e-01
I~ Clip to Range I 0.0009378394 1.104091 77301
" Draw Profies 7 g
™ Draw Mesh Surfaces =] =] B A3e-01
airfoil_lower 5.08e-01
airfoil_upper 5.53e-01
Levels Setup default-interior . 497201
|2D ﬂ I 1 ﬂ farfield 442801
= = 3.87e-01

3.32e-01
surface Name Pattern ~ New Surface- | 277601
I Match | Surface Types = j 2.22e-M

axis o~ 1.66e-01
clip-surf 1.17e-01
exhaust-fan _I 561802
fan b 9.38¢-04
Display | Computel Close Help | Contours of Mach Number Mov 18, 2010

ANSYS FLUENT 13.0 (2d, dbns imp, 55tk
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Post Processing [FLUENT]

* Plot the pressure coefficient (Cp) along the upper and lower airfoil
surfaces.

Customer Training Material

[ solution X¥ Plot x|
Options Plot Direction j i
[V Node Values X1 Pressure... j
o ) |
||:Posmo; g;jxlf Ylo (Bressure et 9
* Results > Plots > XY Plot > Set Up nerore ||| XA Functon
[ order Points z I 0 IDirecho‘ n Vector j
File Data =]
B FLuEnT [1] ANSYS Inc
Load File.
Free [Data | New Surfacer |
750801 - Axes.. | curves..| dose | Hep
500e-01  °
2 50e-01 /
-
Pressure 000e+00  * seneet
Coefficient : . L
-2 50e-01 " .«
. o = *
-5.00e-01 . .
(Y L
-7.508-01 \ o009 "
-1.00e+00 Seantto g, s
-1.25e+00
] 0.1 0.2 0.3 04 05 0.6 0.7 0.3 0.8 1
Position (m)
Pressure Coefficient Mowv 18, 2010
ANSYS FLUENT 13.0 (2d, dins imp, sstia)
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NANSYS

* Now load the test Cp data for comparison
* Load File > browse to the .xy files placed earlier in the user files

folder

Customer Training Material

R Select File x|
Look in: I | user_files j Q@ F [ Er
= - Name = |v| Date modified |
@ Solution XY Plot test-data-bottom.xy 26/02/2009 21:37
Options Plot Direction Y Axis Function ltest: data-top.xy 26/02/2009 21:38
[+ Node Values KI 1 IPremure...
[+ Position on X Axi -
Pressure Coefficient
I Position om ¥ Axis YI D I
[ Write to File X Axis Function
™ arder Points Z I 0 ID'lrecljon Vector
FeData _ _=|=| :
Pressure Coefficient Ltue
Pressure Coefficient
|
11 : | »
11 oK
I I Files oftype: IXY Files ﬂ Cafjcel
= -F'k; XY File(s) HE! M
E:\Training\R13\droper\airfoil\workshop\naca0012_files\user_fil
E:\Training\R13\droper\airfoil\workshop\naca0012_files\user_fil
«| |
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Post Processing [FLUENT]

* Once loaded, plot the CFD and experimental Cp results together.
* A good agreement can be seen.

NANSYS

Customer Training Material

B FLUENT [1] ANSYS Inc

2.50e-01 3 /
Pressure 0.00e+00 b L e

Coefficient N RO L L
-2 50e-01 . A A R R
-5.00e-01 ¥ v ¢
) Y
-7.508-01 \ L
-1.00e+00 (R
-1.25e+00
-0.2 0 0.2 04 0.6 0.8 1
Position (m)

Pressure Coefficient Mow 18, 2010

ANZYS FLUEMT 13.0 (2d, dbns imp, sstiw)
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Post Processing [FLUENT] P ——————

* In order to obtain a good drag prediction, and for the turbulence
model to work effectively, the mesh is well resolved near to the wall,
such that the first grid point is located in the viscous sub-layer, with
Y+ of 5 or less (ideally around 1).

« XY Plot > Turbulence > Wall Y Plus > along both of the airfoil walls.
 We can see that Y+ is around 2.5 for much of the surface, max Y+ < 3

@] solution XY Plot

Options Plot Direction Y Axis Function

[ Node Values x[7 Turbulence...
[ Position on X Axis

Ed

g

[™"| Position o ¥ Axis | || Y Ig— Wall Yplus H
s Funcuon

=l

e

[~ write to Fle iy
I~ | Grder Points I 0 ID‘Irecljon Vector

ﬂ j Surfaces J

DDDDDDD

File Data Wall 1 60e+00

Yplus

DDDDDDD

o1 0.2 0.3 04 0.8 08
Load Fie... iti
| New Surfacer Position (m)

all vplus Nov 18, 2010
Axes... | Curves... | Close | Help ANSYS FLUENT 13.0 (2d, dbns imp, sstikw)
——
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Post Processing [CFD POST]

Customer Training Material

* File > Save Project (save the project from the FLUENT file menu)
* File > Close FLUENT

Additional post-processing will now be performed in CFD Post.
Return to the Workbench Project window.
* Click on ‘Refresh Project’ and notice the Results cell update.

* Right click the Results cell and select Edit. This will launch CFD Post.

Fle View Toobk Units Help
_INew [ Open... ia Save (&l Save As... |g1Import... | <o Reconnect & Refresh Project - Update Project | (3

B Analysis Systems =

EA Design Assessmen t = 2

;g] Electric  Fluid Flow (FLUENT)

I Explicit Dynamics 2 |@ Imported Mesh ke

& Fluid Flow - Blow Moldir 3@ Setup

& Fluid Flow - Extrusion (F 4§ Solution v,

B Fluid Flow (CFX)

& Fluid Flow (FLUENT) Edit...
& Fluid Flow (POLYFLOW) Mach_0.7 !

Harmoanic Response =2 Dupicate
3 Linear Buckling Transfer Data From New  »
@ Magnetostatic 7 Update
EH Modal

Clear Generated Data

il Modal (Samce
¢ ) 2 Refresh

{ili Random Vvibration
Il Response Spectrum Reset

B2 Rigid Dynamics K Delete

2l Shape Optimization BHE Rename
E Static Structural Properties
el Static Structural (Samce

3 steady-State Thermal Quick Help
Thermal-Electric

B Transient Structural

¥ Transient Thermal

El Component Systems

4 BladeGen
@ crx
rd
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Post Processing [CFD POST]

* CFD Post works in 3D, so a unit thickness will be automatically be
added to the 2D airfoil, with symmetry side boundaries.

Customer Training Material

File Edit ion Insert Tools Help
B E % @9 || Buatn - MESSE s BEFO|x @EEN® O # 4 B

outline | variables | expressions | calcuistors | Turbo | IsllEvaaalsE o |is |
T3 Cases View 1
B Mach_{
e & fluid

Pt airfoil_lower
D19t airfoil_upper

ANSYS, Inc. Proprietary Release 13.0

© 2010 ANSYS, Inc. All rights reserved. December 2010




WS2: Transonic flow over NACA0012 Airfoil
Post Processing [CFD POST]

* Insert a new Contour and accept the default name ‘Contour 1’
— Insert > Contour (or use the icon)

* In the details panel, choose an existing location: ‘symmetry 1’
* Choose the variable to be ‘Pressure’ then click Apply

NANSYS

Customer Training Material

& A5 : Mach_0.7 - CFD-Post
File Edit Session

Choose all domains, so that the contour
| & % s @ 0 @ Locston dek=z=o wsnarox will apply to both cases when a
Ouine | variobe 52 vectr fors | Tuto | comparison is carried out shortly.

e cees 1

5 & fluid & Streamline
- OP% = Particle Track

ools Help

-

-~ O
ops

() Volume Rendering

.
Di: W Text

..... b

EF‘ Default T E% Legend

- D Wiref B

©-El Report  Gf2 Clip Plane
- Mg Title ) Color Map
- @& File R

=8 User Locat (> Coordinate Frame

E
- [t Defar .
iy 21 Instance Transform

- Mg Mesh g¢ variable

- #l&d> Physi :

- O Solut Expression
User E Table

@ (2 pisplay Prc 5 chory

frn B A e B

al
al
al
al

Comment
Figure

ANSYS, Inc. Proprietary

Details of Contour 1
Geometry | Label Render I Viewl

Domains IAII Domains

3.

Locations lsymmetry 1 I

B[l

Variable Pressure

]

Range IGIobaI
Min
Max

Boundary Data  Hybrid

K
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101029 [Pa]

& Conservative

Color Scale ILinear

=l

Color Map IDefauIt (Rainbow)

| B

# of Contours |11

™ Clip to Range

=

Reset | Defaultsl
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Post Processing [CFD POST]

Customer Training Material

N@||Om £ 7 7w a & b
EYE & & = DY e =

SEIEEY =l
|)ls-a@als 0 [n |
View 1

* Click on the Z-axis in the
coordinate system triad to
orient in the XY plane.

* To zoom in:
left mouse button
(or mouse wheel)
* To pan:
<CTRL> + middle mouse

* Or use the toolbar icons to
switch between modes
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Post Processing [CFD POST]

» A useful feature in CFD Post is the ability to load multiple sets of CFD
and/or test data, and to then compare any two of them together to
generate a difference plot.

* File > Load Results > browse to the user files folder

— Load ‘mach_0.5_comparison.dat.gz’
— Click OK if an information dialog box appears

Customer Training Material

@ Load Resulis File LI
Look in: I E:\Training\RlB\dropenlauﬂlz_mes\user_ﬂles |'| o O O Li @ [ZE] - case options

mach_0.5_comparison.cas.gz

. My Com... - ]
" b [&=| :mach_0.5_comparison.dat.gz W Keep current cases loaded
] ocume... [T
EI mach_0.7_converged.cas.gz [ Rt
| droper mach_0.7_converged.dat.gz
l user_files [~ Edit case names

— Additional actions

™ Clear user state before loading
W Maintain camera position

¥ Load particle track data

— CFX run history and multi-configuration options—
& Load only the last results

" Load complete history as:

¥ A single case
File name: Ilmach_D.S_comparison.dat.gz I |

" Separate cases
Files of type: IAII Readable Files (res *.res *.mres *.def *.gtm *.cfx *.trn *.bak ’j Cancel |

| BN
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NANSYS

Post Processing [CFD POST]

- Make sure that two windows are open and that each case is displayed

in a different window.

* Lock the views so they are synchronised.

Customer Training Material
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Post Processing [CFD POST] ANSYS

Customer Training Material

* Double-click ‘Case Comparison’ to open the details panel.
- Activate, and select the cases to compare (there are only two here).
« Apply. The pressure difference between the two cases is plotted.

@ A5 : Mach_0.7 - CFD-Post

P[] JE3 |
File Edit Session Insert Tools Help
BE% D9 o) Buan - [2EEEE s HEA0|x@EE NS |0 £ 7 79 B
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= View3 | Difference ¥

) NANSHES
Pressure.Difference
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0P farfield 1.987e+001 / \
O+ symmetry 1 l
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& @) Case 2 (mach_0.5_comparison) -2.823e+003

= & fluid J
g - -5.666e+003
9% airfoil_upper
Of: e - -8.508e+003
D;: symmetry 1 .
Obt symmetry 2 |
User Locations and Plots -1.135e+004 \ |
Contour 1 f |
& Default Transform r-1.419e+004
#I[}} Default Legend View 3 \
P& Wirerame L _
1 Report 1.704e+004 { |
Pl Title Page \
& File Report r-1.988e+004 ! |
& Mesh Report ! ‘ _ |
& Prysics Report -2.272e+004 aie T
& Solution Report e -
User Data o F
Display Properties and Defaults -2.557e+004 \ /

-2.841e+004 \ y
Details of Case Compari [Pa] 4
e
Deﬂnmonl /

¥ case Comparison Active

Case1 [Mach 07 |
Case2 |mach 0.5 comparison |
Opt

¥ Synchronize camera in active views

™ Use absolute value of Difference

Mesh Detection |Auto-detect same mesh =l
i
(9
b3
[ 0500 1.000 (m)
]
0.250 0.750
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Summary

Customer Training Material

* In this workshop ANSYS FLUENT has been used within a workbench
project to compute the transonic, compressible flow over a naca0012
airfoil.

- The implicit density based solver with solution steering was
employed.

 Computed results have been compared to published experimental
data and good agreement was achieved.

« A case comparison has been carried out within CFD Post to compare
the pressure fields at Mach 0.5 and Mach 0.7
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